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RX72M Group  
Communications Board EtherNet/IP Startup Manual 
Introduction 
This application note is a quick start guide for EtherNet/IP communication with the RX72M communication board for 
industrial network evaluation. 
 

This stack runs on E-Force's real-time OS "μC3 (micro-C-cube)" and TCP/IP protocol stack "μNet 3 (micro-net-cube)". 

 

Target Device 
RX72M Group 

 
 

 

Sample program 
This sample program uses the evaluation version of EtherNet/IP stack of our partner: JSL Technology Co., Ltd. 

 

Please contact JSL Technology Corporation for the purchase of the official version and the specifications of the sample 
program. 

JSL Technology Co., Ltd .: https://jslt.co.jp/ 

 

 

【Restrictions】 

The evaluation version of the EtherNet/IPIP stack is a library file built with the following functional restrictions, and 
can only be used for evaluation. It cannot used for integration into the product. In that case, please consider purchasing 
the official version. 
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1. Operating Environment 
The sample program in this manual assumes the following environment. 

 

Table 1.1 Operating Environment 

Item Description 
Board RX72M communications board 

TS-TCS07298 from Tessera Technology  
CPU RX CPU (RXv3) 

R5F572MNDxBD 
Operating frequency CPU clock (CPUCLK): 240 MHz 
Operating voltage 3.3 V 
Operating modes Single chip mode 
Device requirements R5F572MNDDBD  

• Code flash memory 
Capacity: 4 Mbytes 
ROM cache: 8 Kbytes 

• Data flash memory 
Capacity: 32 Kbytes 

• RAM / extended RAM 
Capacity: 512 Kbytes / 512 Kbytes 

Communications protocol EtherNet/IP (Version 3.5.7.0, Tested with ODVA CT18.1) 
Available port CN2, CN3 
Integrated development environment e2Studio V7.5.0 or later 
Tool chain C/C ++ compiler package V3.01.00 or later for RX family 
Emulator (ICE) Renesas E2 Lite 

 
 

1.1 Stack compatible specifications 
The supported stack specifications are as follows. 

 

・CIP Networks Library, CIP, Volume 1 (Edition 3.15, November 2013) 

・CIP Networks Library, EtherNet/IP, Volume 2 (Edition 1.16, November 2013) 
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1.2 Supported CIP Object 
The following CIP objects are supported. 

 

CIP Objects 

0x01 : Identity 

0x02 : Message Router 

0x04 : Assembly 

0x06 : Connection Manager 

0xF5 : TCP/IP Interface 

0xF6 : Ethernet Link 

 

 

1.2.1 Identity Object, Class 0x01 
The support status of “Identity Object, Class 0x01” is described below. 

 

■Class Attributes 

Id Description Get Data Type Value 

01h Revision 〇 - 1 

02h Max Instance 〇 - 1 

03h Number of instances 〇 - 1 

 

■Class Services 

Id Service 

01h Get_Attributes_All 

0Eh Get_Attribute_Single 

 

■Instance Attributes 

Id Description Get Data Type Value 

01h Vendor Id 〇 UINT 0x451(1105) “Renesas Electronics” 

02h Device Type 〇 UINT 0x2b (43) "Generic Device" 

03h Product Code 〇 UINT 0x65（101） 

04h Revision 〇 UINT 3 

〇 UINT 5 

05h Status 〇 WORD Bit 0: Owned  
Bit 1: Reserved, set to 0  
Bit 2: Configured  
Bit 3: Reserved, set to 0  
Bit 4-7: See Extended Device Status  
Bit 8: Minor Recoverable fault  
Bit 9: Minor Unrecoverable fault  
Bit 10: Major Recoverable fault  
Bit 11: Major Unrecoverable fault  
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Bit 12-15: Reserved, set to 0  
Extended device status (Bit 4-7)  
0000 = Self-Testing or Unknown  
0001 = Firmware Update in Progress  
0010 = At least one faulted I/O connection  
0011 = No I/O connections established  
0100 = Non-Volatile Configuration bad  
0101 = Major Fault  
0110 = At least one I/O connection in run 
mode  
0111 = At least one I/O connection 
established, all in idle mode  

06h Serial Number 〇 UDINT 0x00000001（１） 

07h Product Name 〇 SHORT_ 
STRING  

 

0F 45 49 50 53 2d 44 45 4d 4f 2d 52 58 37 32 
4d  
Size: 15Byte  
“EIPS-DEMO-RX72M” 

 

 

■Common Services 

Id Implemented Service 

Class Instance 

01h 〇 〇 Get_Attributes_All 

05h - 〇 Reset 

0Eh 〇 〇 Get_Attribute_Single 

 

 

■Reset Services 

Parameter Service 

0 (Power Cycle) Save the current value in non-volatile memory and reset the power 
supply 

1 (Return to Factory Defaults ) Save the default value to non-volatile memory and reset the power 
supply  

 

 

 

1.2.2 Message Router Object, Class 0x02 
The support status of “Message Router Object, Class 0x02” is described below. 

 

* Access to Class Attributes and Instance Attributes for this object is not supported. 

* Message Router Object is used only to route Explicit messages to other objects. 
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1.2.3 Assembly Object, Class 0x04 
The support status of “Assembly Object, Class 0x04” is described below. 

 

■Class Attributes 

Id Description Get Data Type Value 

01h Revision 〇 UINT 2 

02h Max Instance 〇 UINT 199 

03h Number of instances 〇 UINT 8 

 

 

■Instance Attributes 

Id Access Rule Name Data Type Value 

03h Set by instance Data ARRAY of BYTE Set by instance 

 

 

■Instance 101, 103, 104, 106 

Id Access Rule Name Data Type Size Value 

03h Get Data ARRAY of BYTE 8 00 00 00 00 00 00 00 00 

 

 

■Instance 102, 105 

Id Access Rule Name Data Type Size Value 

03h Get / Set Data ARRAY of BYTE 8 00 00 00 00 00 00 00 00 

 

 

■Instance 198, 199 

Id Access Rule Name Data Type Size Value 

03h Get / Set Data ARRAY of BYTE 0  

 

 

■Common Services 

Id Implemented Service 

Class Instance 

0Eh 〇 〇 Get_Attributes_Single 

10h - 〇 Set_Attribute_Single 
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1.2.4 Connection Manager Object, Class 0x06 
The support status of “Connection Manager Object, Class 0x06” is described below. 

 

■Class Attributes 

Id Description Get Data Type Value 

01h Revision 〇 UINT 1 

02h Max Instance 〇 UINT 1 

03h Number of instances 〇 UINT 1 

 

 

■Instance Attributes 

Id Description Get Data Type Value 

01h Open Requests  〇 UINT  0 

02h Open Format Rejects  〇 UINT  0 

03h Open Resource Rejects  〇 UINT  0 

04h Open Other Rejects  〇 UINT  0 

05h Close Requests  〇 UINT  0 

06h Close Format Requests  〇 UINT  0 

07h Close Other Requests  〇 UINT  0 

08h Connection Timeouts  〇 UINT  0 

 

 

■Common Services 

Id Implemented Service 

Class Instance 

01h 〇 〇 Get_Attributes_All 

0Eh 〇 〇 Get_Attribute_Single 

 

 

■Object-Specific Services 

Id Implemented Service 

Class Instance 

4Eh - 〇 Forward_Close  

54h - 〇 Forward_Open  

5Bh - 〇 Large_Forward_Open  
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1.2.5 TCP/IP Interface Object, Class 0xF5 
The support status of “TCP/IP Interface Object, Class 0xF5” is described below. 

 

■Class Attributes 

Id Description Get Data Type Value 

01h Revision 〇 UINT 4 

02h Max Instance 〇 UINT 1 

03h Number of instances 〇 UINT 1 

 

 

 

■Instance Attributes 

Id Description Get Data Type Value 

01h Status 〇 UINT  2 

02h Configuration Capability 〇 UINT  32 

03h Configuration Control 〇 UINT  0 

04h Physical Link 〇 STRUCT of:   - 

Path size  UINT 2 

Path Padded 
EPATH  

20 F6 24 01 

05h Interface Configuration 〇 STRUCT of:  0 

IP Address UDINT  0A 01 A8 C0  
“192.168.1.10”  

Network Mask UDINT  00 FF FF FF  
“255.255.255.0”  

Gateway Address UDINT  00 00 00 00  
“0.0.0.0”  

Name Server UDINT  00 00 00 00  
“0.0.0.0”  

Name Server2 UDINT  00 00 00 00  
“0.0.0.0”  

Domain Name STRING 00 00 

06h Host Name 〇 STRING  0 

08h TTL Value 〇 USINT  1 

09h MCast Config 〇 STRUCT of:  - 

Alloc Control USINT 0 

Reserved USINT 0 

Mun Mcast UINT 32 

Mcast Start Addr UDINT 20 02 C0 EF  
“239.192.2.32”  

0Ah SelectAcd Get/Set BOOL  1 
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0Bh LastConflictDetected  Get/Set STRUCT of:  

AcdActivity  USINT  

RemoteMAC  Array of 6 
USINT  

00 00 00 00 00 00  
Mac address “00:00:00:00:00:00”  

ArpPdu  ARRAY of 28 
USINT  

00 00 00 00 00 00 00  
00 00 00 00 00 00 00  
00 00 00 00 00 00 00  
00 00 00 00 00 00 00  

0Dh  Get/Set   

 

 

■Common Services 

Id Implemented Service 

Class Instance 

01h 〇 〇 Get_Attributes_All 

0Eh 〇 〇 Get_Attribute_Single 

10h - 〇 Set_Attribute_Single 
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1.2.6 EtherNet Link Object, Class 0xF6 
The support status of “EtherNet Link Object, Class 0xF6”” is described below. 

 

■Class Attributes 

Id Description Get Data Type Value 

01h Revision 〇 UINT 4 

02h Max Instance 〇 UINT 3 

03h Number of instances 〇 UINT 3 

 

 

■Instance Attributes 

Id Description Get Data Type Value 

01h Interface Speed 〇 UDINT  Set by instance 

02h Interface Flags 〇 DWORD  Set by instance 

03h Physical Address 〇 Array of 6 USINT  Set by instance 

04h Interface Counters  〇 STRUCT of:   - 

In Octets   UDINT Set by instance 

In Ucast Packets  UDINT Set by instance 

In NUcast Packets  UDINT Set by instance 

In Discards  UDINT Set by instance 

In Errors  UDINT Set by instance 

In Unknown Protos  UDINT Set by instance 

Out Octets  UDINT Set by instance 

Out Ucast Packets  UDINT Set by instance 

Out NUcast Packets  UDINT Set by instance 

Out Discards  UDINT Set by instance 

Out Errors  UDINT Set by instance 

05h Media Counters  〇 STRUCT of:  - 

Alignment Errors  UDINT  Set by instance 

FCS Errors  UDINT  Set by instance 

Single Collisions  UDINT  Set by instance 

Multiple Collisions  UDINT  Set by instance 

SQE Test Errors  UDINT  Set by instance 

Deferred Transmissions  UDINT  Set by instance 

Late Collisions  UDINT  Set by instance 

Excessive Collisions  UDINT  Set by instance 

MAC Transmit Errors  UDINT  Set by instance 

Carrier Sense Errors  UDINT  Set by instance 
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Frame Too Long  UDINT  Set by instance 

MAC Receive Errors  UDINT  Set by instance 

07h Interface Type  〇 USINT  Set by instance 

08h Interface State  〇 USINT  Set by instance 

0Ah Interface Label   〇 SHORT_STRING   Set by instance 

0Bh Interface Capability  〇 STRUCT of:  - 
Capability Bits  DWORD Set by instance 
Speed/Duplex Options  STRUCT of:  - 
Speed/Duplex Array Count  USINT Set by instance 
Speed/Duplex Array  ARRAY of: - 
Speed/Duplex Pair  STRUCT of: - 
Interface Speed   UINT Set by instance 
Interface Duplex Mode   USINT Set by instance 
Interface Speed  UINT Set by instance 
Interface Duplex Mode  USINT Set by instance 
Interface Speed  UINT Set by instance 
Interface Duplex Mode  USINT Set by instance 
Interface Speed  UINT Set by instance 
Interface Duplex  USINT Set by instance 

 

 

■Instance 1 (Port 1) 

Id Description Get Data Type Value 

01h Interface Speed 〇 UDINT 0x00000064 (100)  
100Mbps  

02h Interface Flags 〇 DWORD 0x0000000F (15)  
“Successfully negotiated speed and duplex”  

03h Physical Address 〇 Array of 6 USINT 12 34 56 78 36 15  
Mac address “12:34:56:78:36:15”  

04h Interface Counters  〇 STRUCT of:   - 

In Octets   UDINT 0 

In Ucast Packets  UDINT 0 

In NUcast Packets  UDINT 0 

In Discards  UDINT 0 

In Errors  UDINT 0 

In Unknown Protos  UDINT 0 

Out Octets  UDINT 0 

Out Ucast Packets  UDINT 0 

Out NUcast Packets  UDINT 0 
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Out Discards  UDINT 0 

Out Errors  UDINT 0 

05h Media Counters  〇 STRUCT of:  - 

Alignment Errors  UDINT  0 

FCS Errors  UDINT  0 

Single Collisions  UDINT  0 

Multiple Collisions  UDINT  0 

SQE Test Errors  UDINT  0 

Deferred Transmissions  UDINT  0 

Late Collisions  UDINT  0 

Excessive Collisions  UDINT  0 

MAC Transmit Errors  UDINT  0 

Carrier Sense Errors  UDINT  0 

Frame Too Long  UDINT  0 

MAC Receive Errors  UDINT  0 

07h Interface Type  〇 USINT  0x02 (2)  
“Twisted-pair”  

08h Interface State  〇 USINT  0x01 (1)  
“The interface is enabled”  

0Ah Interface Label   〇 SHORT_STRING   06 50 6f 72 74 20 31  
Size: 6Byte  
“Port 1”  

0Bh Interface Capability  〇 STRUCT of:  - 
Capability Bits  DWORD 0x00000006  

Auto-negotiate, Auto-MDIX  
Speed/Duplex Options  STRUCT of:  - 
Speed/Duplex Array Count  USINT 4 
Speed/Duplex Array  ARRAY of: - 
Speed/Duplex Pair  STRUCT of: - 
Interface Speed   UINT 10 
Interface Duplex Mode   USINT 0 
Interface Speed  UINT 10 
Interface Duplex Mode  USINT 1 
Interface Speed  UINT 100 
Interface Duplex Mode  USINT 0 
Interface Speed  UINT 100 
Interface Duplex  USINT 1 
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■Instance 2 (Port 2) 

Id Description Get Data Type Value 

01h Interface Speed 〇 UDINT 0x00000064 (100)  
100Mbps  

02h Interface Flags 〇 DWORD 0x0000000F (15)  
“Successfully negotiated speed and duplex”  

03h Physical Address 〇 Array of 6 USINT 12 34 56 78 36 15  
Mac address “12:34:56:78:36:15”  

04h Interface Counters  〇 STRUCT of:   - 

In Octets   UDINT 0 

In Ucast Packets  UDINT 0 

In NUcast Packets  UDINT 0 

In Discards  UDINT 0 

In Errors  UDINT 0 

In Unknown Protos  UDINT 0 

Out Octets  UDINT 0 

Out Ucast Packets  UDINT 0 

Out NUcast Packets  UDINT 0 

Out Discards  UDINT 0 

Out Errors  UDINT 0 

05h Media Counters  〇 STRUCT of:  - 

Alignment Errors  UDINT  0 

FCS Errors  UDINT  0 

Single Collisions  UDINT  0 

Multiple Collisions  UDINT  0 

SQE Test Errors  UDINT  0 

Deferred Transmissions  UDINT  0 

Late Collisions  UDINT  0 

Excessive Collisions  UDINT  0 

MAC Transmit Errors  UDINT  0 

Carrier Sense Errors  UDINT  0 

Frame Too Long  UDINT  0 

MAC Receive Errors  UDINT  0 

07h Interface Type  〇 USINT  0x02 (2)  
“Twisted-pair”  

08h Interface State  〇 USINT  0x01 (1)  
“The interface is enabled”  

0Ah Interface Label   〇 SHORT_STRING   06 50 6f 72 74 20 32 
Size: 6Byte  
“Port 2”  

0Bh Interface Capability  STRUCT of:  - 
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Capability Bits  〇 DWORD 0x00000006  
Auto-negotiate, Auto-MDIX  

Speed/Duplex Options  STRUCT of:  - 
Speed/Duplex Array Count  USINT 4 
Speed/Duplex Array  ARRAY of: - 
Speed/Duplex Pair  STRUCT of: - 
Interface Speed   UINT 10 
Interface Duplex Mode   USINT 0 
Interface Speed  UINT 10 
Interface Duplex Mode  USINT 1 
Interface Speed  UINT 100 
Interface Duplex Mode  USINT 0 
Interface Speed  UINT 100 
Interface Duplex  USINT 1 

 

 

■Instance 3 (internal) 

Id Description Get Data Type Value 

01h Interface Speed 〇 UDINT 0x00000000 (0)  
0Mbps  

02h Interface Flags 〇 DWORD 0x00000010 (16)  
“Successfully negotiated speed and duplex”  

03h Physical Address 〇 Array of 6 USINT 12 34 56 78 36 15  
Mac address “12:34:56:78:36:15”  

04h Interface Counters  〇 STRUCT of:   - 

In Octets   UDINT 0 

In Ucast Packets  UDINT 0 

In NUcast Packets  UDINT 0 

In Discards  UDINT 0 

In Errors  UDINT 0 

In Unknown Protos  UDINT 0 

Out Octets  UDINT 0 

Out Ucast Packets  UDINT 0 

Out NUcast Packets  UDINT 0 

Out Discards  UDINT 0 

Out Errors  UDINT 0 

05h Media Counters  〇 STRUCT of:  - 

Alignment Errors  UDINT  0 

FCS Errors  UDINT  0 

Single Collisions  UDINT  0 
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Multiple Collisions  UDINT  0 

SQE Test Errors  UDINT  0 

Deferred Transmissions  UDINT  0 

Late Collisions  UDINT  0 

Excessive Collisions  UDINT  0 

MAC Transmit Errors  UDINT  0 

Carrier Sense Errors  UDINT  0 

Frame Too Long  UDINT  0 

MAC Receive Errors  UDINT  0 

07h Interface Type  〇 USINT  0x01 (1)  
“The interface is internal to the device”  

08h Interface State  〇 USINT  0x01 (1)  
“The interface is enabled”  

0Ah Interface Label   〇 SHORT_STRING   08 69 6e 74 65 72 6e 61 6c  
Size: 8Byte  
“internal”  

0Bh Interface Capability  〇 STRUCT of:  - 
Capability Bits  DWORD 0x00000006  

Auto-negotiate, Auto-MDIX  
Speed/Duplex Options  STRUCT of:  - 
Speed/Duplex Array Count  USINT 4 
Speed/Duplex Array  ARRAY of: - 
Speed/Duplex Pair  STRUCT of: - 
Interface Speed   UINT 10 
Interface Duplex Mode   USINT 0 
Interface Speed  UINT 10 
Interface Duplex Mode  USINT 1 
Interface Speed  UINT 100 
Interface Duplex Mode  USINT 0 
Interface Speed  UINT 100 
Interface Duplex  USINT 1 

 

 

■Common Services 

Id Implemented Service 

Class Instance 

01h 〇 〇 Get_Attributes_All 

0Eh 〇 〇 Get_Attribute_Single 

10h - 〇 Set_Attribute_Single 
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■Object-Specific Services 

Id Implemented Service 

Class Instance 

4Ch - 〇 Get_and_Clear 

 

Get_and_Clear corresponds to the following Instance Attribute. 

・ 0x04: Interface Counters 

・ 0x05: Media Counters 

 

The value of each attribute is reset to 0 after the service is executed. 
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1.3 Sample program folder structure 
The release folder structure is described below. 

 

[eip_adpt] 

 | 

 |-[lib]：library 

 | 

 |-[prj_rx72m_e]：e² studio folder 

 | 

 |-[src]：Source folder 

     |-[app] 

     |   |-[rx72m] 

     |       |-[uC3]：uC3 main, driver 

     |          |-[odva]：EDS/STC file 

     |          |    |-[eds]：EDS file “Renesas RX72M EIP Adapter Sample.eds” 

     |          |    |-[stc]：Structure file for CT18.1 test ”Renesas EIP RX72M Sample.stc” 
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2. Setting up and Connecting the Evaluation Board 
For detailed information on the board, refer to the RX72M Group Communications Board Hardware Manual. 

 
 
 

 
 
 

Figure 2.1 Configuration of the RX72M Communications Board 
 
 

2.1 Setting up the Board 
Before supplying power to the board, set up jumpers and connect the cables. In addition, make settings for the JTAG 
configuration mode. This mode is normally used with a short circuit between jumper pins 2 and 3.  

 

For the detailed locations of the related parts, refer to the RX72M Communications Board Hardware Manual.  

 
 
 

Figure 2.2 Setting up Jumper Pins 
 

 

2.2 Selecting the Power Source 
Power to the RX72M can be supplied from a 5-V DC power source or through the USB port. Use whichever is suitable 
for the configuration of your operating environment. 

 

 

 

RESET switch 

Power LED 

CAN I/F (J5) 

 

 

DC5V power  
supply 

USB serial 
(power supply) 

Ether IN 

 

Jumper pins 
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3. Installing the e2 studio 
Download RX72M compatible e2studio (V7.5.0 or later) from the following website. 

https://www.renesas.com/e2studio_download 
 
 

3.1 Installing the CC-RX Compiler V3.01.00 
The compiler selection screen appears while installing e2studio. By selecting [Renesas CCRX v3.0 1.00] and selecting 
[Next], CC-RX V3.0 1.00 compiler compatible with RX72M will be installed together. 
 

 

 
 
To start e2studio, please run "e2studio.exe" located in the installed folder below. 
 

e2_studio_rx72m\eclipse 

 
  

https://www.renesas.com/e2studio_download


RX72M Group Communications Board EtherNet/IP Startup Manual 

R01AN4884EJ0106  Rev.1.06  Page 21 of 54 
Jan. 31, 2023  

3.2 Registering the Tool Chain 
Register the CC-RX compiler v3.01.00 so that it can be used with the e2 studio for RX72M. 

(1) Start the e2 studio for RX72M. 
 

(2) Select [File] → [New] → [C/C++Project] → [Next].  

 

 
 
(3) In the [Templates for New C/C++ Project] dialog box, select [Renesas RX] → [Renesas CC-RX C/C++ Executable 

Project] → [Next].  

 

 
(4) In the [New Renesas CC-RX C/C++ Executable Project] dialog box, enter a desired project name and select [Next]. 
 
 

(5) In the [Select toolchain, device & debug settings] dialog box, select [Toolchain Management] under [Toolchain 
Settings]. 
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(6) In the [Renesas Toolchain Management] dialog box, select [Add] → [Browse...] to refer to the installation folder 

"C:¥Renesas¥RX¥3_0_1".  
The registration was successful if "v3.01.00 has been added under "Renesas CCRX". 
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4. Evaluation environment construction method 
The following describes method to build a development environment. 
 
4.1 Preparing the evaluation environment 
(1) Preparing the environment folder 

Release environment ( unzid download folder) in an optional folder. 

ex：C:\proj\eip_adp 

 

(2) EDS File 
Use the EDS file in the following folder for the EDS file.eip_adpt\src\app\rx72m\uc3\odva\eds 

・Renesas RX72M EIP Adapter Sample.eds 

 
 

4.2 Execution procedure 
Describes the procedure to execute communication in the sample application.  

 

(1) After starting e2studio, click "File"-> "Import". 

 

(2) In the "Select" dialog, select "General" → "To an existing project to workspace" and click "Next". 

 

 

 

  



RX72M Group Communications Board EtherNet/IP Startup Manual 

R01AN4884EJ0106  Rev.1.06  Page 24 of 54 
Jan. 31, 2023  

 

(3) Select the "Select root directory" check box in the "Import project" dialog and click "Browse". Select 
“prj_rx72m_e” and click “Open”. Click Finish to complete the project import. 

 

 

 

 

(4) Select the "main" project in the [Project Explorer] field, select the arrow next to the [Build] button (hammer icon), 
and select [HardwareDebug] from the drop-down menu. 
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(5) e2studio builds the project. Once the build is complete, you can start debugging by selecting the arrow next to the 
Debug button (bug icon) and selecting "Debug Configuration". 

 

 

 

(6) Select “main HardwareDebug” and select [Debug] to download the program to the target. 
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(7) If a firewall warning is displayed for "e2-server-gdb.exe", check the checkbox for [Private networks, such as my 

home or work network] and select [Allow access].  
 
(8) The User Account Control (UAC) dialog box may appear. Enter the administrator's password and select [Yes].  
 
(9) If the Confirm Perspective Switch dialog box appears prompting you to switch the perspective, check the 

checkbox for [Remember my decision] and select [Yes].  
 
(10) The green "ACT" LED on the E2 Lite debugger will be continuously lit.  
 
(11) After downloading the code, select the [Resume] button to run the code. The code will break at the address where 

the main function starts. Select the [Resume] button again to continue to run the code. 
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5. Confirmation of sample project operation 
This chapter describes the sample project operation check using the CODESYS software PLC. 

Connect the communication board and PC according to “5.1 Connection Configuration”. Connecting the PC and USB 
Serial of the communication board turns on the power to the communication board. 

 

 

Figure 5.1 Connection configuration 
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RX72M communications board 
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5.1 Starting the CODESYS and Creating a New Project 
 

5.1.1 Starting the CODESYS 
Select “All Programs” > 3S CODESYS > CODESYS > CODESYS Vx.x (x.x represents the version number) from the 
Windows start menu. 

You can also startup the program by double-clicking on the "CODESYS" icon, which will be created on the desktop 
after the installation of the program. 

 

5.1.2 Creating a New Project 
Select "New Project" from the "File" menu to create a new project. 

 

 

In the "New Project" window, select "Projects" from the "Categories" section and "Standard project" from the 
"Templates" section.  
Then, specify the name of the project and its location and click on "OK". 
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In the "Standard Project" window, select the controller and programming language you wish to use from the drop-down  
lists for "Device" and "PLC_PRG in". For this example, select "CODESYS Control Win V3" and "Structured Text (ST)",  
respectively. (If the 64-bit version is installed on the PC, select "CODESYS Control Win V3 x64") 
 After that, click on "OK" to open the new project 

 

 
The "Device" tree for the newly created project will be displayed as shown below.  

The components that belong to "Device (CODESYS Control Win V3)" are managed in a tree structure. 
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5.1.3 Starting the Gateway Server 
Check the state of the gateway server on the system tray. If the server is down, click on the " " icon and select "Start  
Gateway" to start the server up. Usually, the server will automatically be started as a standard service on booting of  
Windows and its status are indicated in the system tray in the lower-right corner of the desktop. 
 

 

 
 
5.1.4 Starting the Software PLC 

Check the state of the software PLC on the system tray. If the program is stopped, click on the " " icon and select  
"Start PLC" to start the program up. Usually, the program will automatically be started as a standard service on booting  
of Windows and its status is indicated in the system tray in the lower-right corner of the desktop 
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5.1.5 Configuring a Device Network 
This section describes device configuration, including the setting of an IP address for use in a network of devices. 

 
Setting the Host IP Address 

Set the IP address before configuring the device. 

Open "Network Connection". 

 

 
In the "Local Area Connection Status" window, select "Properties". 
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In the "Local Area Connection Properties" window, highlight "Internet Protocol Version 4 (TCP/IPv4)" then click on the  
"Properties" button. 

 

 
Select the radio button "Use the following IP Address" and set IP and subnet mask. However, the network IP address 
should match with Device IP. 

 

 
This is the end of the configuration. 
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5.2 Connection setting with CODESYS 
5.2.1 Select device 
Make connection settings for connecting the software PLC service from your development environment. Double-click on  
the "Device (CODESYS Control Win V3) in the "Device" tree. On the "Device" tabbed page, select "Connection settings"  
and click on the "Scan network…" button. 

 

 
The "Select Device" window opens and a search for available devices that can use the local network automatically 
starts. Finding a software PLC service constitutes success and the name of the corresponding PC will be indicated. 
Double-click on the PC name to make a connection.  
If the service will not be found, check the settings described in previous sections, 5.1.3Starting the Gateway Server and 
5.1.4Starting the Software PLC. 
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5.2.2 Installing the Device Information 
Install an EDS (electronic data sheet) file which contains a description of the EtherNet/IP slave device. A file for use 
with EtherNet/IP is provided with the released stack. 

 

Select "Device Repository…" from the "Tools" menu of the CODESYS program. 
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In the dialog box, click on the "Install" button to produce the dialog box where you are to enter the name of the provided  
EDS file. Specify " Renesas_RX72M_EtherNetIP_Adapter.eds ". The result of installation will be indicated under the 

file name. An  

icon " " appears in the case of normal installation, as is shown within the blue rectangle in the figure below 
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5.2.3 Adding EtherNet/IP Device 
Add necessary devices to the "Device" tree. 
 
(1) Adding Ethernet 

Right-click on "Device (CODESYS Control Win V3)" in the "Device" tree and select "Add Device". 
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The "Add Device" dialog box opens. Select "Ethernet" under "Fieldbusses", "Profinet IO", then "Ethernet Adapter" and 
click on the "Add Device" button. 
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You can see that "Ethernet" has been added under "Device (CODESYS Control Win V3)" in the "Device" tree. 

 

 
 
(2) Adding EtherNet/IP Scanner 

Right-click on "Ethernet (Ethernet)" in the "Device" tree and select "Add Device". 
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The "Add Device" dialog box opens. Select "EtherNet/IP Scanner" under "Fieldbusses", "EtherNet/IP", then 
"EtherNet/IP Scanner" and click on the "Add Device" button. 
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You can see that "EtherNet/IP Scanner" has been added under "Ethernet" in the "Device" tree. 

 

 
 
(3) Adding Renesas_EIP_Adapter 

Right-click on "EtherNet_IP_Scanner" in the "Device" tree and select "Add Device". 
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In the Add Device dialog, select “EIPS-DEMO-RX72M” under “Fieldbusses – EtherNet / IP – EtherNet / IP Remote 
Adapter” and click the “Add Device” button. 

 

 
“EIPS-DEMO-RX72M” is added as a device under “EtherNet_IP_Scanner” in the device window. 

 

 



RX72M Group Communications Board EtherNet/IP Startup Manual 

R01AN4884EJ0106  Rev.1.06  Page 42 of 54 
Jan. 31, 2023  

(4) Configuring the Ethernet 
Double-click on "Ethernet (Ethernet)" in the "Device" tree to open the configuration window. In the "General" tabbed 
page, click on the icon next to the text box for "Interface" section as shown in a red rectangle below 

 

 
In the "Network Adapters" window, select the interface you wish to use from among the interfaces offered for  
connection. 

 

 
Confirm that the correct IP address is set for the interface you have selected 
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(5) Setting of EtherNet/IP_Scanner 
 
Users do not need to make settings for this device. 

 
(6) Setting of EtherNet/IP_Adapter 
Double-click on "EtherNet_IP_Scanner (EtherNet_IP_Scanner)" in the "Device" tree to open the configuration window. 
Then, select the "General" tab.  

The EtherNet/IP system recognizes slave devices by the IP address. Enter the address set within the slave device ( For 
setting method please refer to 6.6 IP address setting method).  
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5.3 Connection confirmation with CODESYS 
This section describes how to run a program on the CODESYS development environment and how to ensure connection 
of the device. 

 

Select "Build" from the "Build" menu. 

 

 
Select "Login" from the "Online" menu 

 

 
Select "Start" from the "Debug" menu. The project will automatically start on Windows 

 

 
 
  



RX72M Group Communications Board EtherNet/IP Startup Manual 

R01AN4884EJ0106  Rev.1.06  Page 45 of 54 
Jan. 31, 2023  

The states of connection will be indicated next to each device name. Successful connection is indicated by the " " icon  
as shown in the tree view below 

 

 
 
The icons indicating status of each device is listed below. 

 : The application is connected to the PLC and is running. 

 : The application is connected to the PLC but is not running. 

 : Error. Check the error contents and the settings of the device. 

 
: There is no device information in the device repository. Review the device information file and re-

install it. 
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6. Debug function 
The debug function is described below. 

 

6.1 Terminal software settings 
Debug logs can be output via USB Serial (CN4). 

 

(1) Start the "Tera Term", press the "new connection" in the "File", and then select the COM port. 

 

 

 

(2) Select the USB serial port for log output. 

 

 

note 
It is different from the port for 

communication. 
 

 

  



RX72M Group Communications Board EtherNet/IP Startup Manual 

R01AN4884EJ0106  Rev.1.06  Page 47 of 54 
Jan. 31, 2023  

 

(3) Set serial communication parameters from "Serial Port" in "Settings". 

 

 

 

(4) Configure the serial port settings as shown in Figure 5.14. 
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6.2 Version confirmation method 
The version confirmation method is described below. 

 

The following command  

“Ver” 

Version can be confirmed by typing from the console. 

 

■Version displayed terminal. 

======================================= 

ver 
JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0  
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
======================================= 

 

 

6.3 MAC address confirmation method 
The MAC address confirmation method is described below. 

 

The following command 

“mac r” 

MAC address can be confirmed by typing from the console. 

 

■Mac address displayed terminal. 

======================================= 

Mac r 
 
MAC : 12:34:56:78:36:15 
======================================= 
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6.4 IP address confirmation method 
The IP address confirmation method is described below. 

 

The following command 

“ip r” 

IP address can be confirmed by typing from the console. 

 

■IP displayed terminal. 

======================================= 

ip r 
 
IP Address : 192.168.000.10 
======================================= 

 

 

6.5 MAC address setting method 
The MAC address setting method is described below. 

 

6.5.1 Method of change MAC address from code definition change 
The following describes how to change the MAC address by changing the definition on the source code. 

 

MAC address setting 

   "12.34.56.78.36.15" 

It is set to. 

 

When changing the MAC address, 

The following file 

eip_adpt *** \ src \ app \ rx72m \ uc3 \ user_main.c 

Edit the following definitions. 

====================================== 

char uaser_app_mac[6] = { 0x12, 0x34, 0x56, 0x78, 0x36, 0x15 }; /* MAC Address */ 

====================================== 

The above will be updated by the initialization process “user_net_init”. 
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6.5.2 Method of change MAC address from the Console. 
The following describes how to change the MAC address from the console. 

 

After the power is turned on, the MAC address and IP address can be changed for 5 seconds (definition: 
INIT_SET_WAIT). 

（Other than this 5 seconds, MAC address rewriting from the console is not accepted.） 

 

The following is a countdown terminal. 

 

■countdown terminal 

======================================= 

JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>5 
======================================= 

The following string from the console at the above time 

“Mac w” 

By entering, you will enter the MAC address rewrite mode. 

 

■MAC rewrite mode terminal 

======================================= 

JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>mac w3 
MAC write Sequence Start !! 
If you want to cancel sequence, Please push Enter Key !! 
 
MAC :>12:34:56:78:36:15 
======================================= 
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Move the cursor to the position and set the desired value from the console. 

(Enter the values for all the parts that do not change. If you fail, please start from the beginning.) 

 

■Setting completion terminal 

======================================= 

JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>mac w3 
MAC write Sequence Start !! 
If you want to cancel sequence, Please push Enter Key !! 
 
MAC :>12:34:56:78:90:12 
 
MAC : 12:34:56:78:90:12 
 
Write OK ? : Yes->[y]Key / No-> Other Key 
MAC write OK !! 
MAC : 12:34:56:78:90:12 
init_set_wait_time END 
-------------------------------------- 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
Local IP address 192.168.0.10 
00,00,00,00,00,00,00,00 
00,00,00,00,00,00,00,00 
======================================= 

 

After setting the MAC address value from the cursor, click “Write OK?” 

If there is no problem, type "y" from the console. 

(After the setting is completed, the settable time is reset to 5 seconds again.) 

 

This completes the setting. 
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6.6 IP address setting method 
The IP address setting method is described below. 

 

6.6.1 Method of change IP address from code definition change 
The following describes how to change the IP address by changing the definition on the source code. 

 

IP address setting 

  "192.168.0.10" 

It is set to. 

 

When changing the IP address, 

The following file 

eip_adpt***\src\app\rx72m\uc3\user_main.c 

Edit the following definitions. 

====================================== 

unsigned long uaser_app_ipaddr = 0xC0A8000A; /* IP address  (192.168.  0.10) */ 
unsigned long uaser_app_gateway     = 0xC0A80001; /* Gateway     (192.168.  0  1 */ 
unsigned long uaser_app_mask = 0xFFFFFF00; /* Subnet mask (255.255.255.  0) */} 
====================================== 

The above will be updated by the initialization process “user_net_init”. 

 

 
6.6.2 Method of change IP address from the Console. 
The following describes how to change the IP address from the console. 

 

After the power is turned on, the MAC address and IP address can be changed for 5 seconds (definition: 
INIT_SET_WAIT). 

（Other than this 5 seconds, MAC address rewriting from the console is not accepted.） 

 

The following is a countdown terminal. 

 

■countdown terminal 

======================================= 
JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>5 
======================================= 
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The following string from the console at the above time 

 “ip w” 

By entering, you will enter the MAC address rewrite mode. 

 

■IP rewrite mode terminal 

======================================= 

JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>ip w 
IP Address write Sequence Start !! 
If you want to cancel sequence, Please push Enter Key !! 
 
IP Address : 192.168.000.010 
======================================= 

 

Move the cursor to the position and set the desired value from the console. 

(Enter the values for all the parts that do not change. If you fail, please start from the beginning.) 

 

■Setting completion terminal 

======================================= 

JSL EIP PORTING KIT Ver = 1.07 
eForce Operating System Sample Program V2.0 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
PRODUCT NAME = EIPS-DEMO-RX72M 
 
Console Enable. 
> 
>ip w 
IP Address write Sequence Start !! 
If you want to cancel sequence, Please push Enter Key !! 
 
IP Address : 192.168.001.123 
 
IP Address : 192.168.001.123 
 
Write OK ? : Yes->[y]Key / No-> Other Key 
IP Address write OK !! 
IP Address : 192.168.001.123 
init_set_wait_time END 
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-------------------------------------- 
TMG TE, - EtherNet/IP Stack Adapter 
 
 Adapter Stack v3.5.7.0 
 Application   v3.5 
 Revision CIP  v3.5 
 
Local IP address 192.168.1.123 
00,00,00,00,00,00,00,00 
00,00,00,00,00,00,00,00 
======================================= 

After setting the MAC address value from the cursor, click “Write OK?” 

If there is no problem, type "y" from the console. 

(After the setting is completed, the settable time is reset to 5 seconds again.) 

 

This completes the setting. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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All rights reserved.  
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